Geographic Information Systems in Water Resources — Exercise 1

CUAHSI Virtual University, 2019
David Tarboton

Part 1. Refresher on working with ArcGIS Pro

Objective. The objective of this part of the exercise is for us all to get to the same level in working with
ArcGlIS.

Work through the getting Started With ArcGIS Pro Lesson at https://learn.arcgis.com/en/projects/get-
started-with-arcgis-pro/. Even if you are an expert in ArcGIS, this lesson serves as a useful refresher. (It
did for me). If you are an expert, it should not take too long. If you are rusty or still learning, it will take
longer, but establishes an important foundation.

At the end you should have a map layout similar to the below. Fill in the value you calculate in km? in
the label on your map where | have ***,

Deforestation in Rondoniaj, Brazil ot Potential deforestation saved by

David Tarboton g/1/201

A
e &

g

To Turn in: A PDF document for part 1 with the map layout generated at the end of this exercise
depicting the impact of deforestation in this part of Brazil and the potential reduction in deforestation by
canceling the road project.


https://learn.arcgis.com/en/projects/get-started-with-arcgis-pro/
https://learn.arcgis.com/en/projects/get-started-with-arcgis-pro/

Part 2. Building a Watershed Base Map

Objective. This exercise is intended for you to build a base data set of geographic information for a
watershed using the Little Bear — Logan watershed in Logan, Utah as an example. The base dataset
comprises watershed boundaries and streams from the National Hydrography Dataset Plus (NHDPIlus).
In addition, you will create a point Feature Class of stream gage sites by inputting latitude and longitude
values for the gages in an Excel table that is added to ArcMap and the geodatabase.

Getting Started
We'll begin by getting the NHDPIlus data for the region we are interested in from the National Map.

1. Open the National Map Viewer https://viewer.nationalmap.gov/basic/.

2. Atthe left click Hydrography, NHDPlus High Resolution and HU-4 subregion.
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3. Zoom and pan the map to show northern Utah
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4. Click Find Products in the Datasets tab on the left.
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5. Find the result “USGS National Hydrography Dataset Plus High Resolution (NHDPIlus HR) for 4-
digit Hydrologic Unit —1601” and click Download 1 (vector)

USGS National Hydrography Dataset Plus
High Resolution (NHDPlus HR) for 4-digit
Hydrologic Unit - 1601 (published 20180813)
Published Date: 2018-08-13

Metadata Updated: 2019-07-18

Format: NHDPIlus HR Rasters (233.42 MB),
Extent: HU-4 Subregion

6. Save the file NHDPLUS_H_1601_HU4_GDB.zip.
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In this section we establish an ArcGIS Pro Map Project for the exercise, create a feature dataset and
extract the watershed boundary feature class for the watershed of interest into this feature dataset.

We also set the coordinate system to UTM Zone 12.

1. Open ArcGIS Pro and create a new Blank Map Project. | have called this BasemapExercise. It's
a good idea to just use one-word titles for projects because this is the name of the Geodatabase



that you create within the project. In general, ArcGIS likes to have single word titles as the
names for things or otherwise you have to interpret spaces and that can be ambiguous.

Create a New Project

MName BasemapExercise
Location | ChUsers\dtarb\Documents\ArcGISWork

Create a new folder for this project

b4

Cancel

You should see ArcGIS open with a big topographic map of the United States as below
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You should also find that a folder BasemapExercise has been created in the folder where you set
the project to be saved. This will hold all the files for your work on this project. These include
BasemapExercise.aprx, the ArcGIS Pro project file, an empty geodatabase, and some other files.
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2. Move the file you downloaded (NHDPLUS H 1601 HU4 GDB.zip) to this folder and unzip it.
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BasermapExercise.gdb

3. In ArcGIS Pro in the Catalog pane on the right expand Folders -> BasemapExercise to see the
NHDPLUS H_1601_HU4_GDB.gdb geodatabase folder.
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(If necessary right click on the folder to Refresh — if you do not immediately see this folder.)
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Rename

4. Expand the NHDPLUS H 1601 HU4_GDB.gdb folder further intil you see WBDHUS. This is the
US Watershed Boundary Dataset at HUC 8 scale. Drag this onto the Map window.
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You should see the HUC 8 Watershed boundaries displayed.

Adjust the Symbology to have these just show the outline and thick green lines. (Click on the
symbol in contents pane and change settings in the Symbology pane).

Now let’s create a Feature Dataset in the BasemapExercise.gdb geodatabase to hold our
basemap data. We will use a UTM Zone 12 coordinate system. UTM zone 12 is the Universal
Transverse Mercator coordinate system for this part of the world. If you examine the latitude
and longitude coordinates at the bottom of the map, you will see that longitude is around 111W
or-111°. UTM zones are numbered 1 to 60, each being 6 degrees wide from -180° to 180°
longitude. If you work this out you find that UTM zone 12 is from -114° to -108°.




6. Right click on BasemapExercise.gdb and select New -> Feature Dataset.
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The Geoprocessing pane should open with the Create Feature Dataset tool.

7. Enter LittleBearLogan for the Feature Dataset Name and for Coordinate System choose
Projected coordinate system -> UTM -> NAD 1983 -> NAD 1983 UTM Zone 12N.
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Coordinate System b4

Select the Coordinate System to view the available options.
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8. Click Run on the bottom right.

This runs the tool to create the Feature Dataset. One property of a feature dataset is that all the
data it holds is in the same coordinate system. When we move data into this feature dataset,



the UTM Zone 12 coordinate system will be inherited, i.e. the data will be converted (i.e.
projected) to this coordinate system.

You should see the LittleBearLogan feature dataset in the catalog pane
4 W, BasemapkExercise
b Importlog
4 & BasemapExercise.gdb

b [ LittleBearLogan

Now in the map make sure the Explore tool is selected (you may need to select the Map tab at
the top) and click on the Little Bear-Logan HUC 8 indicated.
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The pop up that opens should show the attributes of this HUC 8. If you scroll down you see the
attributes AreaSqKm with value 2289.8 and Shape_Area with value 0.248
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WBDHUS - Little Bear-Logan

OBIECTID 2
TNMID {D855EF1B-AED2-49EC-94B5-
1D81CAOFBDFB}

MetaSourcelD <MNull=
SourceDataDesc <Null=
SourceOriginator <Null=

SourceFeatureID <MNull>

LoadDate 6/11/2012 7:54:57 AM
AreaSgkm 2289.8
Arealcres 565822.24
GMNIS_ID <MNull=
Name Little Bear-Logan
States ID UT
HUCS 16010203
Shape_Length 2.083143
Shape_Area 0.247569
111.6820039°W 41.6712745°M Od & Q

Shape_Area was computed by ArcGIS using the coordinate system of the geodatabase, which in
this case is geographic coordinates (latitude and longitude). Area does not make a lot of sense
here as the lengths N-S and E-W depend on latitude.

AreaSqKm was obtained from the data provider, and is believable.

Be careful of this distinction.

Note also that the HUC8 code for this watershed is 16010203. This is the HUC8 identifier for the

Little Bear-Logan subbasin. This area lies within Region 16, Subregion 01, Basin 02 and Subbasin
03 in the USGS drainage hierarchy, and is technically referred to as a HUC8 subbasin.
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10. Now in the map window click the Select tool and select the Little Bear — Logan HUC 8.
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It should be highlighted pale blue
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11. In Contents on the left, right click WBDHUS8 -> Data -> Export Features.
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In the Geoprocessing pane on the right, the Feature Class to Feature Class tool should open.
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12. Set Output Location to the LittleBearLogan Feature dataset. Pay attention. This is not the
default. Name the output Feature Class Watershed. Click Run (bottom right)

Geoprocessing > B x
-23:—'}' Feature Class to Feature Class :b'
Parameters Environments 0

Input Features
WEBDHLUZ

Output Location
emapExercise\Basernapbxercise.gdb\LittleBearL ogan

Output Feature Class
Watershed

Expression

There is no expression defined.

+ Mew expression -

The result should be a Feature Class “Watershed” added to the map and added to the
LittleBearLogan feature dataset in the BasemapExercise.gdb geodatabase.

13. Clear selections and remove WBDHUS8 from the map.

|

4[] WBDHUS

]

4 Subwatershed
HUCIO | Remove

EN Copy

¢ Remove

[ 1601020301 B AH Remove the selected layers from the map.
[ L

Note that in ArcGIS there is generally a distinction between Remove and Delete. Remove is a
safe action that detaches a data set from a document. Delete is a less safe action, it actually

deletes the object from disk.

14. You should just see the outline of the single HUC8 watershed.
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With the explore tool click on this Feature Class to see its attributes
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MetaSourcelD <Null=
SourceDataDesc <Null>
SourceQriginator <Null=

SourceFeatureID <Null=

LoadDate 6/11/2012 7:54:57 AM
AreasSqkm 2289.8
Arealcres 565822.24
GNIS_ID <Null =
MName Little Bear-Logan
States ID,UT
HUCE 16010203
Shape=Ler‘|gth 288842.026613
Shape_Area 2288164182.45928
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Note that the Shape_Area is 2288 million. The units are square meters (the units of the UTM
zone 12 coordinate system). This is 2288 km?, a number much closer to and consistent with that
provided from the NHDPlus WBD dataset. This value of 2288 km? has been computed in the
projected UTM coordinate system.
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15. In contents right click on Map -> Properties
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In the Map Properties window click on Coordinate Systems and expand Layers and select NAD
1983 UTM Zone 12N.
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Click OK. You should note that the display adjusts and the watershed is a lot longer and
narrower. The Map display is now showing its contents using UTM zone 12 coordinates, rather
than geographic (latitude and longitude) coordinates. These are a truer representation of the
actual shape of the watershed at this scale.

16. Save your project.

Selecting the Subwatersheds in the Study Area
Now let’s add HUC12 subwatersheds to our project.

1. Go back to the Catalog pane on the right and drag the WBDHU12 feature class from the
NHDPIus geodatabase onto the map.

- Feature Class to Feature Class con
View Details Open History

Catalog | Geoprocessing | Symbology
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These HUC12 subwatersheds are smaller than the HUC8 subbasin already identified.
2. In Contents, right click on WBDHU12 -> Attribute Table
Drawing Order

ADMap

4[] WBDHU12

I:l £l Copy
4 Watershd &= Remove

]

Topogryy B Attribute Table
d | Open Table (Ctrl+T)

Open the attribute table for this layer.

T
|
I

Desig

You should see the attribute table for this Feature Class in the bottom panel of the main display.
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There is a column HUC12 that shows the HUC12 identifiers for each subwatershed. There are
also several other useful fields, like TOHUC that gives the identifier of the next downstream
HUC12 for subwatershed connectivity. You can read more about this dataset at
https://www.usgs.gov/core-science-systems/ngp/national-hydrography/nhdplus-high-
resolution. Full documentation is not yet available, but NHDPlus Version 2 documentation
mostly applies. http://www.horizon-systems.com/NHDPlus/NHDPlusV2 documentation.php.
This dataset is still a bit of a work in progress.

To find the HUC12 subbwatersheds within the Little Bear-Logan watershed we want all those
that start with 16010203. Recall that this is the HUC 8 identifier for this watershed.

3. Click on Select By Attributes at the top of the map.
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Select features by their attribute values. ;
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In the Geoprocessing pane on the right, the Select Layer By Attribute tool should open.
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Click New Expression and set Where HUC12 begins with 16010203, and Run.
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Selection type
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You should see just the subwatersheds belonging to this HUC8 selected. At the bottom left you
can toggle the table to display just the rows of the selected Features in the feature class.
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4 AreaSgKm  Areahcres GNISID | Name States HuC12 HUType HuMeod
65.194834  16109.98 <Null> Right Fork Logan Ca... UT 160102030305 Standard KA &
41453646 1024341  <Null> Temple Fork ut 160102030303 Standard KA
86465777 2136614  <Null> Hells Kitchen Canyo... 1D,UT 160102030302 Standard KA
27.103482 2152372 <Null> South Fork Little Bear... UT 160102030103 Standard ID,CD,KA
151962264 3755066 <Mull> Hyrum Reservoir-Litt.. UT 160102030105 Standard ID,OT,DM,CD,]
76.627204 18935 <Mull> Millville Canyen-Blac... UT 160102030209 Standard IT,ID,CD,KA
90315515 22317.43  <Null> Little Logan River-Lo... UT 160102030308 Standard ID,CD,ITKA
138677353 3426789 <Mull> Headwaters East Fork.. UT 160102030101 Standard KA
e ull>  Cottonwood Canyon... UT 160102030306 Standard KA
74005657 1828718 <Nlll>  Mollens Hollow-Blac... UT 160102030202 Standard KA  ESloEipiinireenpse,
- L& 4 View Details Open History
. - - |
27 of 195 selected Filters: | —A + 100% - [ Caalog | Geoprocessing [ Symbology
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5. Right Click WBDHU12 -> Data -> Export Features and save the Selected Features in a Feature
Class “Subwatersheds” in the LittleBearLogan Feature dataset using the Feature Class to
Feature Class tool that opens. Again remember to set the Output Location to the Feature

Dataset you want.

Geoprocessing

(-j Feature Class to Feature Class ()

Parameters Environments )

Input Features

WEBDHL12 - 7
Output Location
se\BasemapExercise.gdpiLittleBearLogan

Output Feature Class
Subwatersheds

Expression

Note that when Features are selected a Geoprocessing tool generally acts only on those selected
features.

The result should be a new Feature Class “Subwatersheds” added to the map and Feature
Dataset. Clear selections and remove WBDHU12 from the map.
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6. Click on the North-Eastern subwatershed on the map

Pop-up » B X
4 Subwatersheds (1)
.
-
Subwatersheds - Beaver Creek
OBIECTID 11 A <
THNMID {53649EC0-4149-44D4-A21A-
443D323117A2%} 5
MetaSourcelD < Mull= e
SourceDataDesc <Null>
SourceOriginator < MNull=
SourceFeaturelD < MNull= \"*. }rr"
LoadDate 1/18/2013 7:08:15 AM P
NonContributingAreaAcres <Null= J,-f‘:.,:,jﬂh
NonContributingAreaSgkKm <Null=
AreasSqkm 109.615759
AreaAcres 27086.62 R
GNIS_ID <Null= r{v’
MName Beaver Creek e
States DUt o
HUC12 | 150102030301 Vv ,_,_;j”‘ _
HIITvne Standard & et
111.5337073°W 41,9967432°N & & Q “’){L
G 7 _— e

This is HUC12 number 160102030301. The position of this in the USGS drainage hierarchy is:
Region 16, Subregion 01, Basin 02, Subbasin 03, Watershed 03, Subwatershed 01, thus making
the HUC8 number 16010203 as we used earlier, and the additional subdivision to the HUC12

level yielding the 27 Subwatersheds in this Subbasin.

7. Open the attribute table for Subwatersheds. Note that while there is a field HUC12 in this table.
There is no field that identifies HUC10 watersheds. Let’s create one.
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8. Click Add Field near the top of the table window.

¥ Delete [H Calculate | Selection: -tEg

| B TRIK AT Rl e LN

‘ - -
|1 Add Field
| 2 Add a new field in this table.
3 Polygon {BFISTES3-8FAZ-446.. <Mull=
4 Polvaon {FB435E44-4A30-4E8... | =MNull=

9. Inthe Fields window that opens enter the name HUC10
T:430,045 Ml | 1147127135287 W 47.58949384° N

B2 Subwatersheds BEEI Fields: Subwatersheds *

Current Layer Subwatersheds -

4 [/ Visible [M]Read Only Field Name Alias Data Type
[] HUType HUType Text
] HUMuod HUMod Text
] TeHUC TeHUC Text
] MHDPlusID MHDPlusID Double
] YPUID WVPUID Text
Shape_Length Shape_Length Double
shapge Lreg Shape_Area Double

O ] |[Focio | Long

Click here to add a new field.

Leave the Data Type as Long (this means a 64 bit integer to the computer) and other entries at
their defaults.

10. Click Save at the top (within the Fields ribbon tab).
abeling Data

s ()

Mew  Save
Field
Changes
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11. Close the Fields window
| 1:450,045

R Subwatersheds X

EE Subwatersheds EEEI Fields: SubwatersheF x

Current Layer

TTL14133487W 41, 58949584 N

Subwatersheds

Ne—/

K &R &R E R E

L& &HO OO O

4 || visible [M]Read Only Field Name

HUType
HUMed
TeHUC
MHDPlusID
VPUID
Shape_Length

Shape_Area

Alias

HUType
HUMed

TeHUC

MHDPlusID
VPUID
Shape_Length
Shape_Area

IHUCH]

Click here to add a new field.

Data Type
Text

Text
Text
Double
Text
Double
Double

Leng

There should now be a column HUC10 in the Subwatersheds table, filled with <Null> content.

-

Field: £3 Add [FF Delete EE] Calculate | Selection: 5 Switch =

4 HUType HUMeod ToHUC MHDPlusID  VPUID 5  Shape Area HUC10
IB'DS Standard KA 160102030307 0600055916 | 1601 14| 651464421213 <Null> |5
303 Standard KA 160102030306 0600055917 | 1601 77 41422539.8478 | <Null>
302 Standard KA 160102030304 0600055920 | 1601 18 | 86401961.088 <Mull=
103 Standard 1D, CD, KA 160102030105 0600055759 | 1601 39 | 87044334.9841 <MNull=
105 Standard 10, OT, DM, CD, KA 160102030403 0600055782 | 1601 J7 15185904662 <Mull=
209 Standard IT,ID,COKA 160102030308 0600055781 | 1601 31 | 76573867.364 <Mull=
308 Standard I0,CD,IT,KA 160102030403 0600055858 | 1601 36 | 90253158.5781 <Mull=
101 Standard KA 160102030104 0600055887 | 1601 3 138575641.6066 | <Mull>
306 Standard KA 160102030307 0600055739 | 1601 3| 71997808.3068F | <Mull=
202 Standard KA 160102030204 0600055806 | 1601 <Mull=
-
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12. Right click on the top of this column and Click Calculate Field

5
Properties

Merge Rule

WEDHU12

? ”TMMID v

Add Mew Source v

Source

— Field Map
Shape_Area Huc1n | Output FiE|d5®
65146442,121202 <N |= Sort Ascending
41422539.84743 <N 4~ Sort Descending
86401961.088342 <M T Custom Sort...
8704334984176 <N e i1 bl
151859046,624006 | <
T6573867.364549 | < @ Calculate Field
90253158.578147 | < L R————
138575641.606677 < Stati

71997208.306835 | «
7394938440705 | <

Sum

Fiele

The Calculate Field Geoprocessing tool should open

13. Enter int(!HUC12!)/100 in the HU10= field and Run.

Set the values of this field by specifying a

calculation expression. If any of the rows in the
table are currently selected, only the values of the
selected rows will be calculated.

Geoprocessing L1 x
G Calculate Field ®
Parameters Environments @
Input Table
| Subwatersheds v|
Field Name
|HUC10 =
Expression Type
Python 3 -.-|
Expression
Fields T Helpers ?
GNIS_ID — conjugate( i
Mame ..denomlnatorﬂ
States Jimag()
HUC12 snurmerator()
HUType real()
HUMad .as_integer_ratio()
ToHUC fromhex()
T Y. =1 L 4 hE}Cn -
|Insert‘u’a|ues v| s _
HUC10 -
|int|: THUC1Z! ) /18@ z
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This is the Python programming language expression for dividing by 100, and by virtue of integer
truncation getting 10 digit HUC values from 12 digit HUC values. The int() is to convert (coerce)
the text HUC12 value into an integer before the divide by 100.

The result should be 10 digit HUC10 values in the HUC10 column. These will be used to
symbolize the display.

B Subwatersheds X

Field: EAdd ﬁDelete @Calculate

4l

Close the Subwatersheds table (for now).

ToHUC
160102030307
160102030306
160102030304
160102030105
160102030403
160102030308
160102030403
160102030104
160102030307
160102030204

Selection:

NHDPlusIDN - VPUID

0600055916
We00055917
0600055920
10600055759
0600055732
0600055731
0600055858
We0H055837
0600055739
10600055806

1601
1601
1601
1601
1601
1601
1601
1601
1601
1601

2% Switch

Shape_Length
39123.328714
30709.714907
43291.881608
53805.833860
67627.402807
46666.650981
55508.350586
68609.010084
43032.740634
46904.462818

Lets symbolize this dataset using this newly created field.

Shape_Area
631464421213

27044334.98417

151859046.6240
76573867.364

9025315857814
138575641.6066]

71997808.3068:
73540384.407 6

HUC10

1601020303
1601020303
1601020303
1601020301
1601020301
1601020302
1601020303
1601020301
1601020303
1601020302

14. Click on the Subwatersheds symbol in Contents to open the Symbology pane. Return to the

primary symbology page if necessary

Symbology - Subwatersheds

-

Format Polygon Symbol

¢ Return to primary symbelogy page |

¥

s i o

Select Unique Values and HUC10
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Symbology - Subwatersheds - 1 x

2B o 4 =
Primary symbology
|Unique‘u"a|ues "|
Field 1 'HuC10 -]
Add field
Color scheme = -!@E-

Claszes | Scales
h + - More =
Symbol Value Label
w |HUC1'U' | 4 values X
I:l 1601020301 1601020301
I:l T 1601020302 1601020302
I:l T 1601020303 1601020303
I:l 1601020304 1601020304
» =all other values=
- * <all othervalue... =all other value...

The result should be a nice display of the HUC10 watersheds and HUC12 subwatersheds.
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Garland

Tr2monton

Brigham

Note that using USGS drainage hierarchy terminology we have one HUC 8 subbasin, with four
HUC10 watersheds and 27 HUC12 subwatersheds.

Let’s determine the area of each of these HUC10 watersheds.

15. Open the Subwatersheds attribute table and right click on the top of HUC10 column and select
Summarize.

bwatersheds

Field: ﬁ Add ﬁ Delete @ Calculate | Selection: 155‘ Switch =
Al TeHUC NHDPlusID  VPUID Shape_Length Shape_Area HUC10 ' R
— . Sort Ascending
I 160102030307 J0E00055916 | 1601 39123329714 65146442,121392 1601020
= Sort Descending
160102030306 J0E00055917 | 1601 30709.714907 41422535.84743 160102
»~
160102030304 Y0600055620 | 1601 43201.881608 | 86401961.088342 16010z Custom Sort..
A 160102030105 J0B00055759 | 1601 53805.838860 87044334.984176 160102 R Hide Field
ACDKA 160102030403 0600055782 | 1601 67627.402807 | 151859046.624006 160102 Calculate Field
KA 160102030308 J0600055781 | 1601 46666.650081 T6573867.364549 160102
Calculate Geomnetry
KA 160102030403 J0E00055858 | 1601 55508.350586 90253158.578147
160102030104 J0e00055887 | 1601 68609.010084  138575641.600677
160102030307 J0E00055739 | 1601 43052.740634 71997808.306835
160102030204 J0e00055806 | 1601 46904.462818 73949384.407605 0
« — |

Create a summary table grouped by the values in
- 1 + 100% ﬁ the current field. If any of the rows in the table are
" currently selected, only the values of the selected
rows will be calculated.

B 00f 27 selected Filters:

—
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16. The Summary Statistics Geoprocessing tool should open. Set the Statistics Field to Shape_Area
and Statistic Type to Sum. Check that the Case field is HUC10 and Run.

Geoprocessing > X
© Summary Statistics ®
Parameters Environments @
Input Table
| Subwatersheds "|

Output Table
| Subwatersheds_Statistics |

Statistics Field(s)

Field (~ Statistic Type
Eape_ﬂxrea v | | Sum '|
| | l
Casef o

| HUC10 -

| |
The result should be a new table “Subwatersheds_Statistics” that shows the summed area and
Frequency (count of the number of HUC12 watersheds in each statistic) for each HUC10.

B gl ULTIET vdiues> 2 . ; ~ . r
o Waterehed (140045 ]| | 112.1003581°W 41.2040342°
I:I B Subwatersheds = Subwatersheds_Statistics X
Topographic Field: B8 B2 FE | Selection: =
4 5Standalone Tables 4 OBJECTID | HUC10 FREQUENCY = SUM_Shape_Area
|ﬂ Subwatersheds_Statistics | I 1 1601020301 5 | 562295332.404057
2 1601020302 9 | 7A2766372.217383
3 1601020303 8 | 646088951.880712
4 1601020304 5 | 337013525.957033
Click to add new row.

17. To export this table right click on Subwatersheds_Statistics -> Data -> Export Table

] 1601020304 GS Disable Pop-ups \‘:\/{]\ M
B <:!l other values> (& Configure Pop-ups

om |

78°W 41.5692148°N + Sele
4 [J] Watershed Data * |E Export Table |
I:l View Metadata Subwatersheds_Statistics X
Topographic /  Edit Metadata ictiog Export Table
4 Standalone Tables Erl Export current table to new table. B

|:l§| Properties

‘E Subwatersheds_Statistics —lTrv—'m 5 | 562295332 404007
2 1601020302 9 | 742766372.217383
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18. In the Table to Table Geoprocessing tool that opens set the Output Location to the
BasemapExercise folder (i.e. outside of the Geodatabase) and Output Name to
SubwatershedStats.csv. Click Run.

Geoprocessing > B X
© Table To Table *
Parameters Environments

Input Rows

Subwatersheds_Statistics -

Output Location
Usersdtarb\Documents\ArcGISWork\BasemapExercise

Output Mame
Subwatershed5tats.csv

Expressicn

You should obtain a comma separated values (csv) file that you can open and work with in Excel
to format nicely for presentation.

19. Save your project.

To turn in: Make a layout map of the Little Bear-Logan subbasin with its HUC10 and HUCI2
watersheds and subwatersheds. Include a scale, north arrow and appropriate title and legend
information.. Prepare a table (Excel is probably easiest) summarizing the area and number of
HUC12 subwatersheds in each HUCI0 watershed.

Note that maps, tables and documents that you turn in should be clearly labeled so that they may be

unambiguously interpreted with a title, scale, north arrow and appropriate title and legend
information.
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Where is My Stuff?

As you work with data in ArcGIS it is important to keep track of where it is, so it does not get scattered
around your computer and lost.

1. Right click on Subwatershed and select Properties.

S

P |:| Map
A| Subwatersheds Data !
HUCIO Sharing r

[ ] 1601020301
[] 1601020302
[ ] 1601020303

LUIIII':JLIIC l'Ll'_l'LI'_l'_'

View Metadata
/" Edit Metadata

[] 1601020304 F Properties
- <all other values> J .
o ] Properties |
4 [J] Watershed

Show the properties for the selected layers,
1 TS .f

Select the Source tab

Layer Properties: Subwatersheds X

_— [etDotssource. |
Set Data Source...

Metadata v Data Source

| Source i Data Type File Geodatabase Feature Class
Elevation Database ChlUsers\dtarb\Documents\ArcGlSWork\BasemapExercise\BasemapExercise.gdb
Selection Feature Class Subwatersheds G
Display Alias Subwatersheds
Cache Feature Dataset LittleBearLogan
Definition Query Feature Type Simple
Time Geometry Type Palygon
Range Coordinates have Zvalue No
Indexes Coordinates have M value Mo
Joins Attachments Mo Attachments
Relates Feature Binning Disabled
Page Query Vertical Units Meter v

| (6] 4 | | Cancel

Notice that this Feature Class you created is in the LittleBearLogan Feature Dataset in the
BasemapExercise.gdb Geodatabase in the location where you created it. It comprises Simple
Features (no topology) that are Polygons (have X and Y values) but have no Z or M values, which
deal with elevation and measure, respectively.

Scrolling down you can examine the Spatial Reference and confirm that the coordinate system being
uses is NAD 1983 UTM Zone 12N, that also has an identifier WKID 26912 from EPSG. WKID stands
for Well Known Identifier and EPSG is the acronym for the European Petroleum Survey Group that
originally developed a registry of coordinate systems.
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General > Extent ry
MMetadata ,
v Spatial Reference :
Source P .
Elevation Projected Coordinate System | MAD 1923 UTM Zone 12N
Selection Projection Transverse Mercator
. WEKID 26912
Display
Cache Authority EPSG
- Linear Unit Meters (1.0]
Definition Cuery 1.0
False Easting 500000.0
Time
False Morthing 0.0
Range
Central Meridian -111.0
Indexes
Scale Factor 0.9995
loins i o
Latitude OF Origin 0.0
Relates
F'age Quer}r Geographic coordinate system  GCS Morth American 1983 -

Layer Properties: Subwatersheds X

[8]4 | | Cancel

If you look at your BasemapExercise folder on disk that was created when you created the project
you will see a number of files, including BasemapExercise.gdb, which is the folder that holds this
data in File Geodatabase format.

ArcGISWerk 2 Mame Date medified Type

BasemapExercise

¥ BasemapExercise.apm 9/4/2019 1017 PM ArcGIS Project File

BasemapExercisePrep

RendeniaDemo

SubwatershedStats.csv.xml

schema.ini

F201 5PM

9/4/2019 %45 PM

XML Document

Configuration settings

RendeniaExercise 0 | SubwatershedStats.csw Microsoft Excel Com...
| NHD_H_1601_HU4_GDB zip BasernapExercise.thx 9/4/2019 6:27 PM TBX File
{ NHDPLUS_H_1601_HU4 GDB.zip | MHDPLUS_H_1601_HU4_GDB.zip 9/4/2019 543 AM Compressed (zipped)...
] NHDPLUS_H_1601_HU4_GDB.xml 7/10/2019 3:49 PM XML Document
Custom Office Templates 5| NHDPLUS_H_1601_HU4_GDBjpg 8/31/2017 8:27 PM JPG File
My Scans Index 8/4/201910:17 PM File folder
original NHDPLUS_H_1601_HU4_GDB.gdb 9/4/201910:18 PM File folder
R BasemapExercise.gdb 9/4/2019 10:36 PM File folder
Zoom info 9/4/2019 %44 PM File folder
# Downloads ImportlLog 9/4/2019 6:27 PM File folder

You do not need to do anything with these files, this is just pointed out to let you know where on
disk your stuff is stored. If you need to move these files to another computer (e.g. from the PC lab
to a thumb drive) or to a different location on your computer, the integrity of the project will
generally be maintained if you move all these files together retaining the relative folder structure.

2. Save your project.
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Flowlines
In addition to watershed boundaries, the NHDPlus geodatabase includes flowlines and estimates of
streamflow that we will now add

1. Inthe Catalog pane locate NHDPlus_H_1601_HU4_GDB.gdb -> Hydrography -> Flowline and
add to the map.

G- 5 BasemapExercise - Map - ArcGIS Pro Feature Layer ? - u] X

Map Insert Analysis View Edit Imagery Share Appearance Labeling Data () David (Utah State University) - [1  ~
e = o HE = B0 ES) Attribut : i P 3 =
@ N -~ I ributes offa ) ) Pause E
e B0 (0 o @ Bow v % BT @ o @i B
ste Explore *® “* Bookmarks Go  Basemap Add Add  Select SelectBy Select By Infographics Measure Locate ConvertTo  Download

Copy Path - & - ToXY - Data- Preset~ - Attributes Location - - & More - Annotation  Map -

Clipboard Mavigate w Layer Selection n Inquiry Labeling Offline i
Contents R . ~  Catalog ~ax
T | search o -] Project Portal Favorites History =

= m search

t= G K oy @ | search )

e a
b gl Maps
Drawing Order
9 . b & Toolboxes
4 [F] Map b 5l Databases
4[7] NHDFIowiine b igE Styles
I¥yes 4 gl Folders
Connector
4 i BasemapExercise
CanalDitch B
Underground Conduit ImportLog
Pipeline 4 [0 BasemapExercise.gdb
StreamRiver 4 5 LittleBearLogan
fdbcnlfath (@ subwatersheds
Cossline [E) Watershed
— <all other values>
Subwatersheds_Statistics
Subwatersheds
4[] Subwatershe: 4 3 NHDPLUS H_1601_HU4 GDB.gdb
Huc1o
4 Hydrography

[] 1601020301 &

[ 1601020302 HYDRO_NET

[ 1601020203 (] HYDRO_NET Junctions

[ 1601020304 & NHDAres

Bl <l othervalues> Srigham =) NHDFIowtine

4[] Watershed (= NHDLine
=] [=) NHDPoint
Topegraphic (B NHDWaterbody
4 Standalone Tables w ‘T NHDPlus
B Subwatersheds_Statistics Mar = 4 T3 wep L
B SubwatershedStats.csv v | 1:450,045 W 110.3052418°W 42.4287520°N v 5 | I | 2| | Catalog | Geoprocessing Symbology

2. Also add NHDPIusEROMMA. This is a table, so nothing is added to the map. This holds NHDPlus
Enhanced Runoff Model (EROM) data that you can read about in the NHDPlus documentation if
interested.

3. Open the table NHDPlusEROMMA and examine its columns.

You should see FlowEstEGageAdjustedMA. This is mean annual streamflow in cfs adjusted for
nearby stream gages. This is an estimate of streamflow in each stream segment.

You should also see NHDPIlusID. This is a unique identifier for NHDPIus flowline reaches.
NHDPIusID is also a field in the attribute table of NHDFlowline. We will use this field to Join
these tables and then extract a subset of reaches that includes flow data.
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4. Right click on NHDFlowline -> Joins and Relates -> Add Join

BLUF CREEx

| Map VALLE
4[7] NHDFlowline e cl e
] Copy - L
Flype R L THZ s
il
Connector H Emove L
CanalDitch Group
Underground Conduit EE Attribute Table
Pipeline s
Add Error Layers
StreamRiver
ArtificialPath Design L4
Coastline
:_|]! Create Chart 4
— <all other values>
5 Mew Report
4 /] Subwatersheds Bl New Repo
Hucio Joins and Relates *|| B AddJoin
I:I el o, Zoom To Layer e Add Join
|:| 1601020502 Zoom To Make Visible emyg :
|:| 1601020303 Join data to this layer or standalone table based on
[ 1601020304 Selection + |BA Spati @common att”bUt_E- i

5. Inthe Add Join Geoprocessing tool that opens set Input Join Field NHDPlusID, Join Table
NHDPIlusEROMMA, and Output Join Field NHDPIusID. Click Run.

Geoprocessing

G

Add Join

Parameters Environments

Layer Mame or Table View

> 1 X

@

| NHDFlowline

! Input Join Field

| NHDPIusID

Join Table

| NHDPIusEROMMA

Cutput Join Field

| NHDPlusID

Keep All Target Features
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6. Now zoom in on a specific stream reach (e.g. the Logan river near Logan) and use the explore
button to examine attribute values.

3 Pop-up -5
%| 4 NHDFlowline (1) o
Hyde F ark
LDgan

| NHDFlowiine - Logan River G /
Enabled True i
OBIECTID 18718 ¥
NHDPlusID 70000600030846 : s
FlowEStARUNoffMA 272.438311 s 3
VelocityARunoffMA 1.92255 -
IncrilowEstARunoffMA 0.111605 R S
FlowEstBExcessETMA 272.438311 T e
VelocityBExcessETMA 1.92255 k e
IncrFlowEstBExcessETMA 0.111605 ) Uoh Sesie |
FlowEstCRefGageRegressMA  272.438311 W
VelocityCRefGageRegressMA 1.92255 R — g
IncrFlowEstCRefGageRegressMA 0.111605 ﬂ},kr
FlowEstDAdditionRemovalMA 272438311 ;
VelocityDAdditionRemoval MA 1.92255
IncrFlowEstDAddition Removal M A bl River Heights
FlowEstEGageAdjustedMA 249.034055
VelocityEGageAdjustedMa ToToEas 3
IncrFlowEstEGageAdjustedMA 0.111605 Frovidence
FlowEstFGageSequesterMA 249.034055 2
IncrFlowEstFGageSequesterMA  0.111605 d’o}_
AddRemoveFlowNotAvailablema 0 %

Gage adjusted streamflow such as the value of 249 cfs can be identified from the joined
NHDPlusEROMMA table.

Next, a spatial query is used to select just the flowlines in the LittleBear-Logan watershed.
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7. Atthe top of the map, click Select By Location

Appearance Labeling Data

v == Attributes [s) ]

Infographics Measure Locate

ibute} Location

Selection

il

Inguiry
Select By Location

Select features using the location of features in
another layer.

e

8. Inthe Select Layer By Location Geoprocessing tool that opens use Relationship “Have their
center in” and Selecting Features “Watershed” and Run.

Geoprocessing - B x
© Select Layer By Location +
Parameters Environments 0

Input Features ':‘f:'
MHDFlowline -

Relationship

Hawve their center in -

electing Features

Watershed - .

Decimal Degrees -
Selection type

Mew selection -

[ Invert spatial relationship

Zoom to selection in the contents to see that all flowlines within the Little Bear-Logan
watershed have been selected.
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B OE o 5 BasemapExercise - Map - ArcGIS Pro Feature Layer ? - o x
Map Insert Analysis View Edit Imagery Share Appearance Labeling Data () David (Utah State University) - L1~
Y. Cut ~ & [ ~ EE == B0 EZ Attributes oY £ii Pause 3 =
% & 5
e A - @@ SAoE k| Al oy @ K
2 opy el [ Clear 3% View Unplaced
Paste _ Explore Bookmarks Go Basemap Add Add Select SelectBy Select By Infographics Measure Locate Convert To  Download
- Copy Path - To XY ~  Data~ Preset~ Attributes Location - - & More - Annotation  Map~
Clipboard Navigate [ Layer Selection & Inquiry Labeling Offline ]
Contents - 4% |[ElMap % ~ | Geoprocessing v L
T | Search £ -] - ®© Select Layer By Location @
— 4 H [N
= E Eﬂr & Parameters Environments @
Drawing Order Input Features (&)
i D Map rs s NHDFlowline =
4[7] NHDFlowline R
= Relationship
i Have their center in -
Connector G
i Selecting Features
CanalDitch P .
Underground Conduit
g Search Distance )
Ritfis Decimal Degrees i
StreamRiver v :
ti
ArtificialPath lection type
s New selection ¥,
Coastline
[ invert spatial relationship
— <all other values>
4[] Subwatersheds
Hucto 3 ]
‘i
[] 1601020301
[ 1601020302
[] 1601020303
[ 1601020304 &
B <all other values>
4[] Watershed
19 Topegrphic
4 Standalone Tables Py B = Select Layer By Location completed. =
[ Subwatersheds Statistics View Details Open History
R SubwatershedStats.csv v [ 1232189 - B 2L B W) | 111.298120°W42.1071377°N. v | & Selected Features: 3417 | Il | & Catalog | Geoprocessing | Symbology

9.

Save these features (with joined streamflow values) to the LittleBearLogan feature dataset using

NHDFlowline -> Data -> Export Features. In the Feature Class to Feature Class Geoprocessing
tool that opens, set the following and Run.

Geoprocessing > B X

© Feature Class to Feature Class +

Parameters Environments @
Input Features =
MHDFlowline - i

Output Location
emapkxercise\BasermapExercise.gdbi\LittleBearLogan

Output Feature Class
Flowlines

Expression

A Flowlines feature class should be added to the map.

Note that this process acts only on the selected features, so serves to subset the NHDFlowline
feature class. Also the data is projected to UTM coordinate system as it enters the
LittleBearLogan feature dataset, and the joined table values are included. There is a lot going on
in this single command.
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10. Remove NHDFlowline and clear selections.
Your map should be similar to

Frelon

- . :
éﬁf

R hemon o %

<
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P¥i
r
=3 bais 2
e

With flow attributes associated with each stream, we can symbolize the streams using
estimated mean annual flow.



11. Right click on Flowlines in Contents and open Symbology

Contents

- 3 x| [E]Map X

T | Search

R =]

=0/ B &

Drawing Order

AMap

4[7] Flowlines

L4

u-

x

Copy

Remove

Group

P Subwatersheds
HUCID
[ ] 1601020301

B

Attribute Table

Add Error Layers

[] 1601020302

Design

[] 1601020303
[] 1601020304

Ll

Create Chart

- <all other val

Mew Report

4 [ ]| Watershed

Joins and Relates

]

Topographic

Zoom To Layer

Zoom To Make Visible

4 5Standalone Tables

Selection

FH Subwatersheds
B Subwatershed?
B WHDPlusEROM

Label
Labeling Properties..,

Convert Labels To Annotation...

rd

Symbology

F‘:m_ Configure Pop- Show symbology for the selected layer.

I5anlE Pop-up
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Set symbology as below

EEge-cor s BasemapExercise - Map - ArcGIS Pro Feature Layer i - u} X
Map Insert Analysis View Edit Imagery Share Appearance Labeling Data () David (Utah State University) ~ [l ~
Cut <é> O M I _/E b EH + EO Fﬁ F‘ F ES| attributes gu":Q ;€|| Pause = Q i
NERR T [ || Od E\? = ] - oy R i A L
Cop e ! L 3 View Unplaced g
: Explore Bookmarks Go  Basemap Add Add  Select SelectBy Select By Infographics Measure Locate Convert o Download
Copy Path - To ~  Datav Preset~  + Attributes Location - - & More - Annotation  Map~
Clipboard Navigate I} Layer Selection & Inquiry Labeling Offline ]
Contents -« 1 x |[ElMap X = Symbology - Flowlines =k
ALl
B Xl L EE =
= # E;j A —
E 'J E + & Primary symbology
Drawing Order G_radua_ted S)_'mhuls =
4[F] Map Field FlowEstEGageAdjustedMA -
4[] Flowlines Normalization | <MNane>
HowEt Coneh it edMA Method Natural Breaks (Jenks)
<8.961163
Classes 5
— £33.734260
— £100.045742 Minimum size |05 pt :
-— 27785157 =
LT Maximum size |4 pt =
- <503.499506
4 [7] Subwatersheds Garland Template =
HuC1o
[] 16n1020301 Ches | e
[ 1601020302
[ 1601020303 More ~
[ reor020304 Symbol Uppervalue  Label
I <all other values> - 8561163 <8.961163
4| Weterhed — < 33734269  «33.734269
O - < 100045742 £100.045742
] Topographic
Ll — < 227851579  <227.851579
4 Standalone Tables
) — < 563499506  <563.499506
EF Subwatersheds_Statistics
EF SubwatershedStats.csv .:
P8
[EE NHDPlusEROMMA . [,_.ﬂ
us3169  -||BRIE B M | musezrmew e212n62N v | Il |2 catalog Geoprocessing | Symbology

Pretty Cool !

To turn in: Make a layout map of the Little Bear-Logan subbasin with its watersheds and NHDPlus

streams symbolized using estimated mean annual flow. Include a scale, north arrow and appropriate

title and legend information.

12. Save your project.

Stream gages

Now you are going to build a new Feature Class yourself of stream gage locations in the Little Bear-
Logan subbasin. | have extracted information from the USGS website at
https://maps.waterdata.usgs.gov/mapper/index.html

SitelD SiteName

Latitude

Longitude

DASgMile

MAFIlow
(cfs)

10105900
10113500

Little Bear River at Paradise, UT
Blacksmith Fork Ab Up And L
Co.'S Dam Nr Hyrum, UT

Logan River Above State Dam,
Near Logan, UT

10109000

41°34'32"
41°37'25"

41°44'36"

111°51'16"
111°44'17"

111°46'55"

182
263

214

92
126

238
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https://maps.waterdata.usgs.gov/mapper/index.html

1. Develop a table containing an ID and the long, lat coordinates of the gages
The coordinate data is in geographic degrees, minutes, & seconds. These values need to be
converted to decimal degrees for the 3 pairs of longitude and latitude values. This is something
that has to be done carefully because any errors in conversions will result in the stations lying
well away from their proper location. | suggest that you prepare an Excel table showing the gage
longitude and latitude in degrees, minutes and seconds, convert it to long, lat in decimal

degrees:

Decimal Degrees (DD) = Degrees +

Min N Seconds
60 3600

Remember that West Longitude is negative in decimal degrees. Shown below is a table that |
created using Excel. Be sure to include at least 5 digits following the decimal point for Longitude
and Latitude data in decimal degrees (LonDD and LatDD). Then save the data from Excel to a

comma separated variables (csv) file.

SitelD  SiteName Latitude LongitudeDASgMile MAFlow Latdeg Latmin Latsec Londeg Lonmin Lonsec Latdd Londd
10105900 Little Bear River at Paradise, UT 41°34'32"  111°51'16" 182 92 41 34 32 11 51 16 41.57556 -111.85444
10113500 Blacksmith Fork Ab Up And L Co.'S 41°37'25"  111°44'17" 263 126 4 37 25 11 44 17 41.62361 -111.73806
10109000 Logan River Above State Dam, | 41°44'36"  111°46'55" 214 238 41 44 36 111 46 55 41.74333 -111.78194
2. Add the CSV table to ArcGIS Pro. Click Add Data and pick Gages.csv
Edit Imagery
Add Data *
T_,' D » Project » Folders » BasemapExercise » v EI Search Project pe
Organize * MNew ltem ~ T HN
4 ‘ = Project | MName Type Date
ol Databases Importlog Folder O/4/2019 6:27 FE
o Folders = BasemapExercise.gdb File Geodatabase  9/4/2019 6:27 PI
4 A Portal Gages.xlsx Excel 952019 1214 £
&, My Content &= NHDPLU5_H_1601_HU4_GDEB.gdb File Geodatabase  9/4/2019 11:50 F
cﬁ' Groups B9 NHDPLUS_H_1801_HU4 GDBjpg Raster Dataset 8/31/2017 827 F
< All Portal Gages.csv Text File 97572019 12:14 4
QI‘ Living Atlas % SubwatershedStats.cov Text File O/4/2019 9:45 FE
4 [0 Computer
Desktop

Gages.csv should appear that the bottom of Contents.

40




3. Convert from tabular values to points. Right click on Gages.csv and select Display XY Data.

=8.961163
=33.734269
=100.045742
=227.851579
=563.499506

-_—
4 Subwatersheds

HUC10

[ ] 1601020301
[] 1601020302
[ ] 1601020303
[] 1601020304

- <all other values=
4 [ | Watershed

]
Topographic

4 Standalone Tables
FH Subwatersheds Statistics
FH SubwatershedStats.csv
B NHDPlusEROMMA

Rermowve

Open

Add Error Layers

Design

Create Chart

Mew Report

loins and Relates

Display XY Data

"
[ |2

Geocode Ta™'

#:I

Disable Pog
Configure F

Display XY Data

Creates a point feature class based on x,y values
from the highlighted table.

LT T

Data

k

N\ [

View Metadata
Edit Metacdata

EH Gages.csv

Properties

1:532,169

JF 3R . a
+| BB %t BB Wy | 112.25408607
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4. Inthe XY Table to Point Geoprocessing tool that opens, use the following settings and click Run.

Geoprocessing > A x
G) XY Table To Point ®
Parameters Environments @
Input Table
Gages.csv -

Output Feature Class
pExerciselBasernapExercise.gdbfLittleBearLogan’Gages

# Field
prafiuls
Londd -

Y Field
Latdd M

£ Field

Tt ek S~ —

GCS_Morth_American_1927 - D

Note that the Gages feature class was saved in LittleBearLogan feature dataset.

Also | used a NAD 1927 coordinate system as | had noted on the USGS website that this was the
coordinate system used by the USGS for gage locations. This can be found in Geographic
Coordinate System -> North America -> USA and Territories.

The stream gages should appear as points on the map. Symbolize them to your taste.
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5. Right click on Gages in Contents and Label to Enable Labeling

F ]

F ]

F |

Gages -
. é‘ CDp}f Flymouth
% Remove
Flowlines = 1
FlowEstEGageAdjusted S ‘
=8.961163 [ Attribute Table
— =33.734269 Add Error Layers e
— <100.045742 : i
— 2227851579 Design
- =363.499506 |_|_|_I Create Chart e
Subwatershed .
4 [/] Subwatersheds ﬁ New Report
HUCIO
I:l 1601020307 loins and Relates L it
I:l 1601020302 o Zoom To Layer
[ ] 1601020303 B o Ermchion:
Zoom To Make Visible
[] 1601020304
- <all other values> Selection
Label
[ | Watershed E Lt
] ¢m Label " B
@ c Enable Labeling
| Topographic ony
e £ Enable labeling of the layer.
4 Standalone Tables ~ Symbolagy I =R
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Contents ARl B Map X |

? | Search P ‘ Meéwhin

=G8N/ 5 &

Smilhfiekd

Drawing Order
4[] Map

4||Z| Gages
@

4 [/] Flowlines
FlowEstEGageAdjustedMA

£8.961163

— <33.734269
= £100.045742
- <797.851579
- 503499506

R e
| Above State Daj

| Near Lo

3

4 Subwatersheds
HUC10
1 1601020301

] 1601020302

1 1601020303

] 1601020304

Il <all other values> ittle/Bedr
4[] Watershed R W?’T .at { §

D ar?_dlse,_ /UT'

[] Topographic

4 Standalone Tables
EH Subwatersheds_Statistics
[ SubwatershedStats.csv
[ NHDPIusEROMMA
R Gages.csv

iy

You may need to adjust label parameters to éhange fdnt, colo

f

ved.

-

Jdispla

o

.orf.iel-d

Zoom in to near each gage and use identify to see the gage streamflow as well as NHDPIlus
FlowEstEGageAdjustedMA streamflow in the reach adjacent to each gage. Prepare a table that
compares gage and estimated streamflow for these three gages.

Well done! In this exercise we started with NHDPIus high resolution data produced by US
Federal Government agencies and shared using the National Map. We identified and selected
the subset of data applicable to our area of interest (HUC 8 Subbasin) and extracted and loaded
this data into a Geodatabase feature dataset with a coordinate system chosen for this area. This
ensures that the data is all consistent and will work together smoothly. We added to this data,
using data produced in Excel and performed some simple analyses such as summing the area
over HUC10 watersheds and comparing information spatially. This illustrates some of the
potential that GIS provides through the analysis of spatially located information — the “science
of where” to borrow the phrase used by ESRI.

To turn in: Make layout map of the Little Bear-Logan subbasin with NHDPlus streams and
streamflow gages labeled. Include a scale, north arrow and appropriate title and legend information.

To turn in: Table comparing gage mean annual flow and NHDPlus mean annual flow for the three
stream gages in the Little Bear-Logan subbasin.
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Summary of Items to be Turned in:

Part 1.

A PDF document for part 1 with the map layout generated at the end of this exercise depicting
the impact of deforestation in this part of Brazil and the potential reduction in deforestation by
canceling the road project.

Part 2.

A separate single PDF or Wordprocessor document with the following

1.

Make a layout map of the Little Bear-Logan subbasin with its HUC10 and HUC12 watersheds
and subwatersheds. Include a scale, north arrow and appropriate title and legend information..
Prepare a table (Excel is probably easiest) summarizing the area and number of HUC12
subwatersheds in each HUCI10 watershed.

Make a layout map of the Little Bear-Logan subbasin with its watersheds and NHDPlus streams
symbolized using estimated mean annual flow. Include a scale, north arrow and appropriate title
and legend information.

Make layout map of the Little Bear-Logan subbasin with NHDPlus streams and streamflow gages
labeled. Include a scale, north arrow and appropriate title and legend information.

Table comparing gage mean annual flow and NHDPlus mean annual flow for the three stream
gages in the Little Bear-Logan subbasin.

Note that maps, tables and documents that you turn in should be clearly labeled so that they may
be unambiguously interpreted with a title, scale, north arrow and appropriate title and legend
information.
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